
THREE
COLOR WORKFLOWS
An extract from the DIGITAL RETOUCHING FOR 
FASHION BEAUTY AND PORTRAIT PHOTOGRAPHY 
by Gry Garness, here are three examples of color 
workflows using adjustment layers. The book is 
full of step-by-step tutorials. These workflows are 
examples where the different approaches and 
many smaller steps come together to give rich 
dynamic color. The possibilities and limitations of 
color adjustment is carefully considered, and the 
image quality should always be our top concern. 
These examples are pretty straightforward, with 
no special effects. They reflect how we work with 
‘normal’ images – first a global correction, then a 
few local corrections – all on adjustment layers, 
so that the adjustments are totally editable, and 
available for blending modes and masking. 

If you find it too subtle, remember that however 
gratifying it may be, big colour adjustments in 
Photoshop will always degrade an image, even 
when applying adjustment layers. 

RESHAPING FEATURES

This sample tutorial demonstrates step-by-
step how you can subtly reshape features 
using a Warp graft and a bit of clever shading, 
while maintaining top image quality for 
those hi-res print images. The tutorial also 
uses Smart Objects and Refine Edge; both are 
features which have emerged in the last two 
versions of Photoshop. You’ll never use the 
Liquify again!
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This underexposed image may be rather gratifying to 
work on, but that may not be such a good thing. It’s 
dark, dull, and rather too cold for its natural style. The 
global adjustments could have been done in the Raw 
converter, where they are much less destructive, but 
I want to give you an example where the difference 
really shows, so I’m taking it into Photoshop without 
making any Raw corrections. In Levels, the Red Channel 
highlight is remapped to 248, and the RGB highlight 
to 203. That means we expand the tonal range with 
52 levels. The fine transitions in the midtones will suffer 
a bit, but that’s the cost of 8-bit manipulation. 

In the last stages some further finessing is done. The 
image has had a subtle darkening Curve revealed 
through a gradient mask on the left hand side, to 
firm up the edge. See more about Gradient Masks on 
p.61. A general brightening Curve is applied through 
a gradient mask into the hair from top right, and also 
applied some more, through brushing the layer-mask 
with White in the hair area. 

The eyes have a small amount of Hue Saturation 
Lightness applied in the whites, and some Saturation 
in the blue of the eye. The lips and cheek are given a 
subtle Red Channel Curves adjustment. 

Finally a Hue Saturation with a strong positive 
Lightness adjustment is blended to Soft Light, and 
painted in selectively – mostly in the hair. At no point 
has the original pixel layer been retouched, but the 
adjustments have improved the image greatly. 

Putting the cursor in what I know to be neutral subject 
whites (while in the Curves dialog) I can read in the 
Info Palette that there is a slightly lower Blue in the 
white wall – in other words, we have a Yellow cast. To 
make the wall crisp and neutral, yet retain the warm 
skin tone, I lift the Blue in the highlights and take it 
slightly down in the face shadow. The Info Palette 
below shows the color numbers before/after. The RGB 
Curve lifts up quite flat in the highlights and midtones, 
which keeps the skin texture smooth. It then steeps 
down towards the shadows, giving the most contrast 
and texture in the midtone-to-shadow area. 

Image 1: The progression from dark and dull capture – to a warm glowing image.
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This is a fairly good capture, but it’s in 8-bit, which is not 
ideal for major color changes. See a slight breakup in 
the Histogram, which would not have shown up in 16-
bit. Although the image is fairly well-exposed, it’s flat 
and uninteresting, and will need a boost in both tonal 
contrast and color contrast. There’s an overall murky 
cast which is slightly hard to define. I need to clean up 
the colors and make the water more shimmery. 

The white clothes have two different casts – a Red cast 
on the left side, and a Blue cast on the right. The cast 
is lifted a bit overall through the color Curves (below), 
and the rest left for correction selectively. The first is a 
very subtle adjustment, knowing that the RGB S-curve 
will bring out the saturation and contrast in the next 
stage. Look at the shape of this slack RGB  S-curve 
– how it lifts the highlights but hardly darkens the 
shadows at all. 

So – to the local adjustments. In the left image the 
water is given a selective Curves adjustment that 
makes it bluer and brighter – more water-like. Flare is 
reduced in the left pillars through a local darkening and 
Curve, reducing the brightness of the flare slightly in 
that area. 

Finally, in the far right image, the jacket and top are 
selectively desaturated in Hue Saturation, and a 
contrast-enhancing Curve is test-patched, filled and 
brushed into the background selectively through a 
layer-mask. This gives the image a bit more ‘crunch’.

This image is taken beyond just color correction. I’ve 
taken liberties with the colors and the tonal relationships 
– heightening the contrast and boosting the atmosphere 
as much as possible, but it still looks fairly natural. 

Image 2: From flat and murky original to a shimmering contrasty image with boosted color. 

The Levels were remapped only in the highlights – to 248. This 
is an acceptable amount of remapping, yet still causes some 
Histogram breakup. If the image had been in 16-bit the breakup 
would not have been visible in the resulting Histogram. 

Above: The Curves individual 
color Channels

Left: The slack RGB S-Curve
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Here’s a good but slightly flat 16-bit scan where there 
is also some leeway for correction. This is ideal if 
you want freedom to play with the tonal relationships 
within the image, without clipping or losing too much 
quality. You won’t see a massive difference in the first 
two stages of this high-key image, despite a remapping 
of 8 levels in the highlights and 1 in the shadows. 
The clouds are a bit brighter and the highlights appear 
somewhat crisper, but the image will need some Curves 
modification in the midtones to give it the contrast it 
needs. 

Here I apply a composite RGB Curve first, because the 
image needs beefing up a bit. I let the sky do all the 
work for me; by choosing a bright point in the sky to 
lift up the Curve, and then a darker cloud, to take it  
down slightly, the whole image is given the contrast 
and richness that it needs, and it’s no longer looking 
bland or washed-out. 

In the color Curve, the Blues (and Greens, to an extent) 
are lifted in the sky tones, and lowered in the shadows 
– which helps separate the pebbles into warm/cold. 
Notice how the image now looks sharper. 

The above left version has a simple darkening Curve 
revealed through a Gradient mask in the sky, to add 
a bit more drama. I mask it off with a Brush where it 
affects the model’s head. I also mask off the corners 
where it’s going too dark, and make sure it’s applied 
fully in the middle of the sky, where it’s needed most. 
All the sky masking is done with the Gradient Tool to 
ensure smooth falloffs. 

A  Curve is applied to the denim skirt, making it brighter 
and more blue. As the skirt covers quite a defined area, 
it can be masked in simply by selecting the skirt with 
the Magic Wand, feathering 2px and filling the mask 
with White.

A Hue Saturation adjustment to make the warm 
stones more vibrant is applied through a gradient 
mask at the front, adding a bit more interest where the 
image is blurry. 

As a result of the corrections, the warm colors are 
warmer, the cool blues are crisper, and there’s more 
richness in the sky and the pebbles. Although this was 
a logical way to go, I can easily think of 12 different 
interpretations for this image. Have a look at those 
other color alternatives on p.43.

Image 3: From washed-out scan to richer tones 

The Levels were remapped slightly in both the highlights and 
shadows. Note how it has no breakup in the resulting Histogram. 
This is because the image was scanned in 16-bit. 

Above left: The composite RGB 
Curve, with (right) the composite 
view of the color Curve in the 
Blue and Green Channels. CS3 
now lets you see this composite 
view, so you don’t always have to 
look into the individual Channels 
to see what’s done there. 
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Before even considering reshaping features, I suggest 
you ask yourself whether it’s necessary and ethically 
correct. When retouching a commissioned portrait, 
the person to whom the features belong should be 
consulted before you reshape their nose or jaw. A 
model would usually be chosen for their existing 
features, but on occasion an unfortunate angle – 
or in this case, strain of the muscles make the jaw 
too square, and the neck muscles bulge. Here, the 
model’s femininity is enhanced without changing 
the appearance of her face. These techniques can 
also be used for reshaping noses, for double-chins 
and for body parts. 

RESHAPING features

After reshaping

Before reshaping

In fact you can apply this method to any part of 
a persons body or face-shape, and that’s why it’s 
important to study the individual’s characteristics 
before you start, so you don’t distort these too much in 
the process. To take an example: I have worked several 
times with this model, and I never considered her jaw 
as being particularly prominent. Therefore she looks 
more like her good self after the retouching than she 
did before. As it was originally, the image couldn’t be 
used, and had been shelved for several years. It was a 
5x4 film capture, and I kicked myself for not shooting 
more variations of the shot. With this easy and subtle 
reshaping, the image regained its worth.

As well as using a  Warp transformation, I’ve redistributed 
the lighting under the chin and at the back of the neck. 
Sometimes you don’t have to transform at all; you 
might solve the problem just by shading alone. For an 
example of this, see also p.69. 
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1. CREATE SELECTION AND LAYER VIA COPY
Make a Pen Tool or a Lasso selection around the chin 
and jaw area – big enough to give some fall-off when 
joining it in afterwards. Press Command+Enter and 
then Command+J to make a Layer via Copy.

2. CONVERT TO SMART OBJECT AND LOWER OPACITY
In the Layers Palette flyout menu, choose Convert to 
Smart Object. This lets you make several transforms 
without degrading the image. Turn the opacity of the 
Smart Object layer to 70%. Be sure to do it in this 
order, or you will be stuck with 70% opacity when you 
later want it back to 100%. 

3. FREE TRANSFORM THE SMART OBJECT
Press Command+T to Free Transform and then press 
the Warp button in the Options bar. You can pull the 
handles and the bars, giving the jaw-line a less angular 
shape. The 70% opacity lets you see through to the 
original. In this example I also transformed the neck 
slightly inwards. Try to not overdo it. You can easily go 
back and transform some more on the Smart Object. If 
you’re dealing with a double, chin, stretch the neck up 
to overlap the chin slightly. 

4. RASTERIZE THE SMART OBJECT
When you’re happy with the transformation, turn the 
opacity back up to 100% and go to Layer>Smart 
Objects>Rasterize, thereby making it a normal layer 
again. By doing this we lose the ability to continue 
transforming lossless, but we regain the ability to 
retouch on the layer. 

5. MASK OFF AND THEN SELECTIVELY REVEAL
Go to Layer>Layer Mask>Hide All and pick a big 
soft Brush Tool, with a White color at 100% opacity 
and flow. Reveal the new transformed jaw and neck, 
making sure the joins are perfect and the gradient of 
the skin is smooth. 

6. SHADING AN IDEAL JAW LINE
For the shading we need to make a selection of the 
ideal jaw-line with the Pen Tool or Lasso Tool. The Pen 
is always best at this, because you can make a perfectly 
smooth line in a very swift operation. Sometime the jaw-
line is weak and almost impossible to determine. In this 
case it’s quite strong, but with a highlight underneath 
that makes it look as if the model has a slight double-
chin – which she certainly hasn’t got in reality. 

7. REFINE THE SELECTION
The softening of the selection depends on the above-
mentioned strength of the existing jaw-line, Go to 
Select>Refine Edge to soften it in the Quickmask 
view, and try to match the strength of the existing jaw 
line, but making it perhaps a touch stronger. You can 
soften it later if necessary. If you’re using non-current 
Photoshop versions you may use Quickmask.

8. MAKE A MULTIPLY CURVES LAYER
With the selection active, make a Curves adjustment 
layer and just press OK without doing anything. Blend 
this layer to darken the selection by scrolling from 
Normal to Multiply in the Layers Palette. You will 
now have a dark neck, which needs some masking. 

9. MASKING THE DARKENING LAYER
Use a very big soft Black Brush Tool at 100% opacity 
and flow. Start from below and brush away the edges. 
You may reduce the opacity once you’ve got rid of the 
hard edges, but the beauty of a soft big brush is that it 
gives a low opacity at the edges. A shadow under the 
chin always helps define the jaw-line.

On review I found that the back of the neck needed some 
deeper shadow, so I used a white brush in the mask to 
apply the darkening effect here. This had the effect of 
seemingly narrowing the neck – a good example of how 
we can reshape without actually transforming.  
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DIGITAL RETOUCHING FOR FASHION, BEAUTY AND PORTRAIT PHOTOGRAPHY, GBP £18.50
Finally – here’s a beauty retouching book aimed at photo professionals. It’s for those who either 
focus entirely on the retouching aspect, or photographers who do their own post-production. 
This inspiring e-book meets the needs of photographers, assistants, digital operators, retouchers, 
and anyone who produces high-quality people-shots that need to stand up to close scrutiny 
and large output sizes. It’s sharp, clean and well designed, letting the images and tutorials 
do the talking. The digital pdf format is the perfect medium because you can zoom in and 
examine the images in detail. The majority of images in the book have been published as 
fashion editorials, high-end magazine covers, advertising campaigns and CD-covers. It’s all 
about transforming good images into stunning images. You’ll find no recipes for transforming 
your granny into a supermodel. Speaking of recipes – the book can be read and used almost 
like a cookbook, with a mix of in-depth retouching concepts and step-by-step tutorials. The 
tutorials are advanced, but as straightforward as possible, with a string of logic going through 
them. The book’s 85 tutorials consist of well-proven techniques and the ‘recipes’ have been 
tested on various photographers and retouchers. Based on Gry’s experience as a Photoshop 
trainer, the tutorials are suitable for all levels. There’s enough detail for inexperienced users, 
and at the same time a fast-track way of skimming the text for advanced users. The general 
emphasis is on making light work of the retouching, by working in a smart and bold way, while 
still keeping it subtle, realistic and editable!

This book extract is avaiable exclusively from 
PhotoshopSupport.com 

SEE LIST OF BOOK CONTENTS

CHECK OUT THE COLOR BOOKS

FREE GRY GARNESS TUTORIALS (not in the 
books)

BUY THE DIGITAK RETOUCHING BOOK

NOTE: Because of web bandwith limitations this document is 
prepared at a lower resolution and image optimization than the 
actual book. The actual book is 300ppi. 
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